Computer skills are often best “learned by doing.” Students will be most interested in step-by-step instructions for opening *Ainsworth Keyboard Trainer, Focus On Grammar*, and *Microsoft Word* that are found in Sections V, VI, and VII.

The other sections provide more detailed information on “how” and “why.” Teachers may find it a useful guide to procedures specific to our lab and to the skills students are expected to master. Students may also consult it for general information and definitions of common terminology used when working with computers.
# TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>I</td>
<td>Lab Rules</td>
<td>1</td>
</tr>
<tr>
<td>II</td>
<td>Parts Of A Computer</td>
<td>2</td>
</tr>
<tr>
<td>III</td>
<td>Getting Started</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>--Checking In/Out With The “Track-it” system</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>--Print cards</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>--Log On And Getting To The “Desktop”</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>--Opening A Program</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td>--Log Off, Restart, Shut Down</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td>--“Escaping” (Ctrl/Alt/Delete)</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td>--PC Versus Mac</td>
<td>5</td>
</tr>
<tr>
<td>IV</td>
<td>Basic Techniques (Common To All Programs)</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>--Using A Mouse</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>--Using A Keyboard</td>
<td>8</td>
</tr>
<tr>
<td></td>
<td>--Navigating A Menu</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td>--Opening, Closing, Changing The Size Of A Window</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td>--Cutting, Copying, Pasting, Inserting</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td>--Saving Work</td>
<td>12</td>
</tr>
<tr>
<td></td>
<td>--Printing</td>
<td>12</td>
</tr>
<tr>
<td>V</td>
<td>Using Ainsworth Keyboard Trainer</td>
<td>13</td>
</tr>
<tr>
<td>VI</td>
<td>Using Focus On Grammar</td>
<td>14</td>
</tr>
<tr>
<td>VII</td>
<td>Using Microsoft Word</td>
<td>15</td>
</tr>
<tr>
<td>VIII</td>
<td>Specific Microsoft Word Skills</td>
<td>16</td>
</tr>
<tr>
<td>IX</td>
<td>Other Programs Available</td>
<td>21</td>
</tr>
</tbody>
</table>
I. LAB RULES

Always:

--Wait for the previous class to leave before the next class enters
--Log off when finished (Shut down only at 9:50PM)
--Return lab manuals
--Wrap wire neatly around headphones
--Ask the teacher or the lab assistant if you don’t understand

Never:

--Eat, drink, smoke, or chew gum in the lab
--Enter the lab assistant’s area
--View pornography from the internet
--Check personal email, unless course-related
--Install new software on the lab computers
--Turn off computer equipment, except to shut down at night
--Use cell phones or converse loudly in the lab

You Can:

--Use a black plastic glare hood for better light reflection
--Adjust the chairs up and down with the right-side lever
II. PARTS OF A COMPUTER
III. GETTING STARTED

Checking In/Out

Students need to insert their ID cards or type in their Student Numbers as they enter and leave the lab. Teachers can obtain a list of their students, with numbers, from Faculty eServices. Students are encouraged to purchase a Student ID Card from the Student Services Office, because it can also be used for printing (and many other student activities).

Print Cards

At this time of writing, the college is implementing a new system for paying to print at any on-campus computer printer. Payment will likely be made through the student’s ID card or through a special print card. Teachers should be made familiar the procedure when the system is in place.

Log On And Getting To The Desktop

Begin by pressing the keys Ctrl-Alt-Delete. This is the first step when using any PC/Microsoft-based computer. Push down each key in order and hold it down, then release.
Each computer in the San Marcos ESL Lab has an identification number on a paper label over the screen. Students log on by typing “morn” (morning program), “eve” (evening program), or “night” (night program) plus the last two digits of the computer’s identification number, with no spaces, under “User name.” Then use the mouse to click “OK” or press the “Enter” key on the keyboard. Leave the “Password” section blank. Example:

**night24** (night program, Computer #24)—Enter

Common mistakes made by students: (1) Misspelling “morn”, “eve”, or “night” (particularly the latter), (2) leaving spaces, (3) typing the info under the “Password” section instead of the “User name” section.

The Escondido ESL Lab has a different log on procedure, but the principle is the same: Students log on at the beginning of a lab session.

When students have successfully logged on, they will reach the blue-screened “desktop” with the Windows Start icon in the lower-left corner. They are now ready to open whatever program the lesson requires. Some programs, particularly MS Word and Internet Explorer, may also be on the desktop, ready to open without going through the Start icon.

Opening A Program

A one-page set of step-by-step instructions for opening the Ainsworth Keyboard Trainer, Focus On Grammar, and Microsoft Word programs are found in Sections V, VI, and VII of this manual.

In general, to open a program you double click on its icon. Some programs, particularly Internet Explorer, may be located on the desktop. Most, however, are located by clicking on the Windows Start icon, then Programs, then double clicking on the program you want to open:

**Start—Programs—Microsoft Office—MS Word**
Log Off, Restart, Shut Down

When you finish working, never turn off the power to the computer. Instead, use the “Shut Down” or “Log Off” function under the Windows Start icon. There is also a “Restart” option under the Shut Down function. If you are in night class and the lab is closing for the day, you may be asked to use Shut Down. Otherwise, use Log Off to ready the computer for other students. Ordinary procedure:

Start—Log Off—Log Off or Start—Shut Down—Log Off—Log Off

If The Computer Stops Working

With PC computers, a useful procedure when you can’t resolve a problem or when the computer “freezes” is to simply start over again. Press the three keys, Ctrl-Alt-Delete in quick succession, and the programs will close and take you back to the desktop. You will, however, lose any work you have done. The Mac has a similar function, called “forced re-start”: Press option-apple(icon)-esc.

With PC: Ctrl-Alt-Delete With Mac: option-apple-esc

PC Versus Mac

Most of the computers in our lab use the Microsoft Windows operating system and are commonly called “PCs.” Most of the procedures in this manual apply specifically to them. There are also a few Apple MacIntosh computers, called “Mac’s.” Macs are very “user friendly”, and a student with knowledge of PCs can often perform basic functions using a Mac with only a little guidance. When possible, inexperienced students should make sure they are using a PC instead of a Mac.
IV. BASIC TECHNIQUES

Using A Mouse

The mouse and the keyboard are used to input instructions and data. Some mouse functions can also be done with the keyboard, but beginners probably find it easier to use the keyboard for inputting letters and numbers and the mouse for all other functions.

Grip the mouse with the buttons and the wire to the computer pointing up. Get used to moving it around the screen to different locations, and notice that you can pick it up and set it back down to continue rolling it in a small space.

The mouse is used to open and close programs and windows, to select functions like **Save** and **Print**, to “scroll” up and down a document, and to change font size, style, margins, spacing, etc.

There are several “mouse techniques” for accomplishing different functions. All of them require you to move the mouse to an icon or a line of text and point at it. Most of them use the left-side button only:

**Double clicking.** This is used most commonly when opening a program or other icon. You click the button twice, quickly, while pointing to the icon of the function you want to carry out. Example: To open Internet Explorer, point to the big blue “e” and click twice. If you double click too slowly, the icon will highlight but not open, as if you clicked only once. Then you have to single click again, or press the “Enter” key on the keyboard, to un-highlight it before you can try again to open it.

**Single clicking and highlighting.** This is usually done to select options after double clicking on an icon. You point to another icon or line of text and click once. Sometimes this will “highlight” an item, making it darker. You can then select from the menu to do something with the item, such as move
it to another place. If you make a mistake, you can un-highlight an item by clicking it again. Other times the arrow that points to the selection will turn into a finger shape when it is ready to click, and the computer will carry out a command.

**Dragging.** The borders of a window can be enlarged, and some items can be moved, by dragging. You click the mouse at the edge or corner of the item, then hold the left button down until you move it to the desired location, and release.

**Selecting/Highlighting.** Similar to dragging, this is most commonly done when you want to copy a section of text or part of a graphic image. You point the mouse at the edge of the item to select, then hold the left button down until the section you want to copy turns dark. Then release the button. This takes some practice, and you can cancel if you make a mistake by moving the mouse away from the section and clicking again.

**Scrolling.** A very common use of the mouse when reading from the screen is to use the vertical line at the right of the document, called the “scroll bar”, to move up or down the lines of text. You can click in the middle square and move up or down rapidly, or you can click in the arrowed boxes at the top or bottom of the document and move up or down slowly.
Using The Keyboard

The concept of “home keys” is essential to typing by touch. The home keys are:

\[\text{a s d f and } \text{j k l ;}\]

You place the four fingers of your left hand on a-s-d-f, and the fingers of your right hand on j-k-l-;, and move the fingers from these home locations to the other keys. Numbers are located above the letter keys, and most punctuation marks (; : ‘ “ , . ?) are found in the lower right corner.

Upper and lower case. There is a Shift key on both sides of the keyboard that you hold down with your end fingers to capitalize a letter, and a “Caps Lock” on the left side that you can press once to make all letters capitals. Press it again to release it. Remember that some computer input is “case sensitive”, meaning you must use capital or small letters for the instructions to work.

Space bar. The long bar at the bottom of the keyboard, you press it with your thumbs to make spaces between words.

Backspace key. You use this to move “backwards” over a short distance. It erases any letters it passes over while backing up, and therefore is a convenient way to correct mistakes.

Insert key. This key, to the right of the main keyboard near the backspace key, is sometimes hit by mistake. It causes new text to be inserted over the old text, erasing the old text as you type. This is seldom a useful function for beginners, and you can cancel the function if you hit it by mistake by simply pressing it again.

Enter key. The two main functions of the Enter key are (1) to skip to a new line of text, and (2) to execute a command with the keyboard instead
of by clicking with the mouse. When writing with a word processing program, remember: You don’t need to press Enter at the end of each line, because the program does it automatically. You use it only when you are starting a new paragraph, or intentionally writing short lines such as in a list.

**Tab key.** Located in the upper left corner of the keyboard, you use it to indent a paragraph.

**Cursors.** Located in the lower right, to the right of the main keyboard, are four keys with arrows. They are sometimes faster to use than the mouse to go to nearby places in the text and add words or correct mistakes.
Navigating A Menu

Once a program is open, you use the mouse to click on options and selections. When you open MS Word, for example, it is ready for you to begin writing. But if you wish to change the pre-set font, size, or margins, you must go to the menu, click various icons, then click on your selections. Very often you must click on **OK** after each selection.

This is the general principle. Many specifics are best learned by trial and error. Remember that all of the Microsoft Office applications are together in a special file under **Programs**. When you know the programs well, you can go from one Microsoft Office application to another, and back.

Opening, Closing, And Changing The Size Of A Window

The three boxes in the upper right hand corner of the window control sizing. The first minimizes the window, and sets it aside with its title at the bottom of the screen so that you can work on something else and come back to it. The second maximizes the size of the window, so that it fills the whole screen. The third closes the window when you are finished working with it.

You can also move the window by clicking and dragging the top, or change the size of the window (if it is not maximized) by clicking and dragging the lower right corner with the diagonal line markings.

Cutting, Copying, Pasting, Inserting

When using MS Word and other programs, you can remove or copy a piece of text, or even a graphic image, and insert it in another place. For example, you can take a sentence out of one paragraph and put it into another without erasing and re-typing the sentence.

**Cutting.** Use the mouse to select and highlight the text or image you want to remove. Then go to the **Edit** menu and select **Cut**. The material will
be removed and stored in the **Paste** function if you want to insert it in another place.

**Copying.** Do the same as if you were cutting, but select **Copy** in the **Edit** menu. The material will not be removed, but will be stored in the **Paste** function. It can be printed as many times as you want to “paste” it in other places.

**Pasting.** After the material has been cut or copied, it can be pasted into another location by clicking the mouse on the spot where you want to put it, then selecting **Paste** from the **Edit** menu.

**Inserting.** You can insert page numbers and other markers by selecting items from the **Insert** menu. When writing a long paper, it is very handy to have a function that keeps track of page numbers automatically!

![Menu for MS Word program with **Edit** open](image)
Saving Work And Accessing It Later

The easiest way to save your work is by having your own floppy disks. The teacher also has a class file on the lab’s network that allows each student in the class to save work there.

To save, go to the File menu and select Save As. This allows you to choose a name you will give to the file, and the place where it will be saved (generally, “3 ½ floppy” or the network file). When you are sure it will be saved in the right place, click Save. Be sure your name appears somewhere on the document, and preferably in the name of the file as well.

To access later, double click on the My Computer icon on the desktop. It will show the floppy disk drive and other places for saving. Click on the appropriate icon and look for your document.

Printing

In the lab, there is a single printer for all of the computers. When you are ready to print, click the Print function under the File menu. Then go to the printer and check to see that your work is ready to transfer to the computer used with the printer. If you don’t see it, click Refresh on the printer’s computer. Then put your print card in the printer, and click Print. Remember to get your print card back when finished!
V. USING AINSWORTH KEYBOARD TNR.

Log On

(1) Press Ctrl-Alt-Delete
(2) Follow log on procedure (see Pg. 4)
(3) Press Enter

Open Ainsworth Keyboard Trainer

(4) Doubleclick on the Ainsworth Keyboard Trainer icon
(5) Type in your Student Number as the password
(6) Click OK
(7) Press Enter
(8) Click on the boxes to select the type of activity
(9) Select from the menu the specific exercise
(10) Read the instructions and click OK (or highlighted box)
(11) Do the exercise (The program records your progress)
(12) Click on Main Menu to choose another activity at any time

Log Off

(13) Click the X box in the upper right corner of the screen
(14) Click Start
(15) Click Log Off, then Log Off again
VI. USING FOCUS ON GRAMMAR

Note: In addition to grammar practice, this program provides good practice with basic techniques using mouse and keyboard. Students must point, click, double click, highlight, and drag items.

Log On

(1) Press Ctrl-Alt-Delete
(2) Follow log on procedure (see Pg. 4)
(3) Press Enter

Open Focus On Grammar And Do Practices

(4) Doubleclick the Focus On Grammar icon on screen
⊙ First Day Only: Click on Start New Workbook instead of #5
(5) Click on Open Old Workbook
(6) Go to Drives. Select \student\dept\esl
(7) Select the program/class you are in (usually with teacher’s name)
⊙ First Day Only: Under File Name, delete * and put your initials
(8) Click on your initials.wbk (Example: KBS.wbk)
(9) Click OK
(10) Click on the unit and lessons to select your exercises.
⊙ You must click OK each time after you select
(11) Follow the instructions in the exercises
(12) When you finish, click Menu, then click on the next exercise

Log Off

(13) Click Quit to close the program
(14) Click Start
(15) Click Log Off, then Log Off again
VII. USING MICROSOFT WORD

Log On

(1) Press Ctrl-Alt-Delete
(2) Follow log on procedure (see Pg. 4)
(3) Press Enter

Open Microsoft Word

(4) Click Start
(5) Click All Programs
(6) Click Microsoft Office
(7) Click Microsoft Word
(8) Click the X in the upper right to remove side window

Make A Document

(9) Type your assignment. Remember: The program changes lines automatically. You don’t have to hit Enter unless you want to skip a line. Hit Tab to indent a new paragraph. More detailed instructions follow this section.
(10) Save or print your assignment (See section on “Saving Work”)

Log Off

(11) Click the X box in the upper right corner of the screen
(12) Click No if you don’t want to save your assignment
(13) Click Start
(14) Click Log Off, then Log Off again
VIII. SPECIFIC MICROSOFT WORD SKILLS

To Create A New Document:

1. Observe insertion point:

   Look for the small blinking vertical line to the left of the paragraph mark. *The insertion point is where characters appear when you type.*

2. Enter text

   - Type your name, press **Enter**.
   - Type your level, press **Enter**.
   - Type the date, press **Enter**.

   Type the following text EXACTLY (There is one intentional misspelling). Press ENTER at the end of the title. Do NOT press ENTER at ends of the other lines:

   **The Importance of Being Bilingual**

   A mother mowse and her baby were running across a floor when they heard a noise. The mother mouse and her baby were frightened, but they stood still, and the mother called out in her loudest voice: “Bow Wow!” It was a cat. The cat ran away. Then the mother mouse turned to her baby and said, “You see, my child, how important it is to know a second language.”

   *The insertion point moves as you enter text. Notice words in the paragraph automatically “wrap” (continue on the next line when the end of the line is reached.)*
3. **Make paragraphs**

- Move the I-beam pointer just to the left of the first line of the document.
- Press the **TAB** key.
- Move the I-beam pointer just to the left of “The cat ran away.”
- Press **Enter**.
- Press the **TAB** key.

4. **Correct errors**

- Move the I-beam pointer just to the right of the “w” in the word “mowse”, then click.
- Press **Backspace** to remove the incorrect character (w).
- Retype to enter the correct character (u).

OR, Press the directional arrows on the keyboard until the insertion point appears to the right of the error.

Then press Backspace one or more times to remove the characters. Retype to enter the correct characters.

**To Align Text:**

1. **Observe the alignment tools on the formatting toolbar:**

2. **Change the alignment of text:**

   - Click to the left of your **NAME**.
   - Click the **align right** tool.
   
   *When you move the I-beam to a tool on the formatting toolbar, the I-beam becomes an arrow and you can see the name of the tool*
   
   - Click to the left of your **LEVEL**.
   - Click the **align right** tool.
   - Click to the left of the **DATE**.
■ Click the **align right** tool.
■ Click to the left of the **TITLE**.
■ Click the **center tool**.

**To Highlight Text:**

1. **Highlight one word**
   ■ Double-click the word.
   *The space after the word is also highlighted*
   ■ Double click your first name.

2. **De-select highlighted area:**
   ■ Click anywhere in the text.
   *Your name is no longer highlighted, and the insertion point is positioned where you last clicked.*

3. **Highlight a block of text.**
   ■ Put the I-beam pointer to the left of the **TITLE**.
   ■ Click to place the insertion point.
   ■ Hold down **SHIFT**.
   ■ Click to put the insertion point after the last word in the **TITLE**.

**To Apply Line Spacing:**

**Double-space paragraph lines:**

■ Click inside the paragraph.
■ Click the double space button on the formatting toolbar.
To Change Fonts And Font Sizes:

1. Check current font and size of text
   ■ Click inside of any word or line, or Highlight any text.
   ■ Click the first word in the TITLE.
   ■ Look at font name and size on formatting toolbar.

   \[ \text{Times New Roman} \quad 12 \]
   The toolbar shows the name and size of the font used for the text.

2. Change the font
   ■ Highlight the TITLE.
   ■ On the formatting toolbar, click the down arrow \( \downarrow \) next to the font name to see the font list.
   ■ On the font list, choose a font.

3. Change the size:
   ■ Highlight the TITLE.
   ■ On the formatting toolbar, click the down arrow \( \downarrow \) next to the current font size.
   ■ On the font size list, choose a font size.

To Apply Font Styles:

1. Add a single style to text:
   ■ Highlight any text, then on the formatting toolbar, click the Bold Tool
   \[ B \]
   The text appears in bold type.

   ■ Highlight “Bow Wow.”
   ■ Click the Bold Tool. \[ B \]
2. Remove the same style.
   - On the formatting toolbar, click  
   ![](image)
   The formatting tool is like an on/off switch, so the style is removed when you click on it again. The orange highlight on the tool tells when it is on.

3. Add styles one at a time
   - Highlight the **TITLE**.
   - On the formatting toolbar, click  
   ![](image)
   - On the formatting toolbar, click the italic tool  
   ![](image)
   - On the formatting toolbar, click the underline tool  
   All three tools now have light highlight
   - Click outside the **TITLE** to de-select it and see the styles.

4. Remove styles one at a time
   - Highlight the **TITLE**.
   - Click the **bold tool**, the **italic tool**, and the **underline tool**.
   - Watch the text change back to normal styles.

**To Cut, Copy, & Paste (Move text to another place):**

   - Click just to the left of “It was a cat.”
   - Highlight “It was a cat.”
   - Click the **copy tool** on the standard toolbar.
   - Click just to the right of the word “noise.”
   - Click the **paste tool** on the standard toolbar.
   Now there are two copies of “It was a cat”
   - Click just to the left of the SECOND “It was a cat, & highlight it.
   - Click the **cut tool**. It is now removed again.
IX. OTHER PROGRAMS AVAILABLE

MS Word is only one of six programs available on Microsoft Office. Word processing is probably the most basic and necessary of computer skills, and so it receives the most attention in our ESL courses. As students acquire skill, they may be ready to use these other programs, which can all be integrated and even uploaded to the Internet for use in websites:

Microsoft Publisher. Used to create and edit newsletters, flyers, advertisements.

Microsoft PowerPoint. For slide shows and presentations.

Microsoft FrontPage. A program especially for website development.

Microsoft Excel. Used to create spreadsheets and graphs, and to analyze quantitative information.

Microsoft Access. For databases and programs involving multiple users and networks of computers.

Palomar College offers Computer Science and Information Systems courses that show how to use these programs for various uses.

Another important program is Internet Explorer, which provides access to the Internet and an almost unlimited world of information, instantly accessible!

The ESL Department is constantly adding new programs and applications to the lab’s computers. Master word processing and typing, and take advantage of the opportunities.